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 Product Description 
Alamut™ Visual Plus is a comprehensive genome browser compliant with HGVS nomenclature and 
powered by multiple genomic sources and prediction tools displayed in an interactive interface to 
ease variant interpretation.  
Alamut™ Visual Plus is an upgrade of Alamut™ Visual.  
 

2. Intended Use/Purpose 
2.1 Intended Use 

Alamut™ Visual Plus is a Research Use Only (RUO) software that assists in routine genomic analysis. 
Alamut™ Visual Plus allows the visualisation of variants, transcripts, genomic sequences, and 
genomic data to simplify variant interpretation and pathogenicity assessment.  
 

2.2 Intended User Profile 

The application is intended to be used by trained medical professionals (clinicians, researchers, 
research technicians, etc.) working in the field of Genomics. 
 

2.3 Intended Use Environment 

The place of use is determined to be in a hospital, laboratory, or clinical setting, on a regular 
computer. 
 
 

3. General Statement of the Test Principle(s) / Procedure 
Alamut™ Visual Plus general procedure is as follows: 
 

• Explore genomic regions 
• Search for specific genomic data (genes, transcripts, variants) 
• Visualise sequence files and variants from BAM, VCF or Sanger 
• Access to multiple genomic databases and prediction tools  
• Manual creation of genomic variants 
• Curation of variant database, occurrences and history 
• Import and export of private variant annotations 
• Reporting of variant data 
• Connect to external resources (API) 
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4. Product Components 
The product is only composed of the Alamut™ Visual Plus software.  
Alamut™ Visual Plus is installed with a floating license. Floating licenses can be used on multiple 
computers, with a limited number of concurrent users and are managed via a web page (extranet). 
Alamut™ Visual Plus extranet page: http://extranet.interactive-biosoftware.com. 
 
Equipment and Materials Required, Not Provided:  
The user needs to provide a computer, a keyboard, a mouse, and an internet connection according 
to section 5.1 of this user guide. 

 
5. Specifications and Installation 

5.1 Specifications 

Alamut™ Visual Plus requires the following technical specifications: 
 

System Component Minimum Requirement 

Operating system 

Microsoft Windows 7 or above, 64-bit version 
The program is available as an installer program (.exe) or self-
extractable archive (.exe) or compressed file (.zip) 
 
Mac OS X- starting from Mac OS 10.14 (Mojave) 

Internet Connection 

Connection to the following IP addresses are required: 
• 20.224.43.76 
• 212.83.147.70 

The software handles connections through HTTP/HTTPS on port 80 and 
443, optionally through a proxy server. 

Hardware Requirements 

Computer: 1.5GHz+ – 8GB RAM – 500MB free disk space. 
Display screen resolution: 1024x768 pixels 
The software program does not alter system directories or the 
registry. Write permissions are required on the software directory to 
ensure continued functioning of the application and to save user 
parameters. 

Installation Instructions 

Alamut Visual Plus should be installed locally. We do not 
recommend sharing a same settings folder between multiple users. 
 
Furthermore, having different versions installed and used 
alternatively is not a good practice, since the databases schema can 
evolve from one version to another.  
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5.2  Installation 

Once the Administrator’s credentials have been created, the Administrator must log-on to the 
Alamut™ Visual Plus extranet page and create a new user account through the “Add user” button. 

 
 
The new user will receive the Institution ID, Username and Password via e-mail.  
If the recipient does not receive the e-mail, the administrator can retrieve a unique link allowing 
them to complete their user account. In the "Users Management" page of the extranet, the 
administrator can copy into their clipboard the URL by clicking on  button and paste it in a 
direct e-mail to the concerned user. 
 
To install the program, the new user must open the Alamut™ Visual Plus extranet page and sign in 
with the Institution ID, Username and Password provided. 
 

 
 
Alamut™ Visual Plus binaries can be downloaded from the “Downloads” section. 
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5.2.1. Install on Microsoft Windows  

Download the Alamut™ Visual Plus Installer or Self-Extractable executable (.exe) from 
our extranet page: http://extranet.interactive-biosoftware.com. 
 

- From the Installer: execute it and choose an installation folder where you have “write” 
permissions 

- From the Self-Extractable executable (.exe) file: double-click on the installer to launch the 
installation program and follow the instructions presented to you. Select a folder where you have 
“write” permissions. 

 
Once the program is installed, the files used for the installation can be removed.  
5.2.2. Install on Mac OS X 

Download the Alamut® Visual Plus (.dmg) file from the extranet page: http://extranet.interactive-
biosoftware.com.  
 

1. double click the .dmg file to make its contents available 
2. drag the application from the .dmg window into the /Applications folder to install (may 

need an administrator password) 
3. You will also have to authorize the installation of this software by clicking on apple sign > 

system preferences > security and privacy > lock sign > allow alamut visual plus software 
4. wait for the copy process to finish 
5. Close the .dmg window  
6. delete the .dmg from Downloads 
7. Now start using the Alamut from the applications folder for the first launch as described in 

5.3 
 

5.3 Post installation: First launch 

 
To set up Alamut™ Visual Plus, launch the software and: 

• Define the application’s data folder, where Alamut™ Visual Plus will store its settings. To 
retrieve your current settings and databases, you may decide to reuse an existing folder 
created by an older version of Alamut™ Visual Plus. By selecting ‘No’, settings will be 
restored.  
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Note: If, for quality purpose, you do need to validate a new version of Alamut™ Visual 
Plus before distributing it in your institution and that you use the shared database 
feature, we recommend you follow these steps (this will require you to install Alamut 
Visual Plus in a different location): 

• Copy the .db files of your current shared databases and store them into a new 
folder 

• Install the Alamut™ Visual Plus version you wish to validate, when asked for, 
choose to use a new settings directory 

• From the Local Variant Databases menu, use the “Add existing database” feature 
and add the databases you have previously copied 
If an upgrade of the database is needed, it will be automatically applied at this 
point. 

• Validate Alamut™ Visual Plus 
• Uninstall Alamut™ Visual Plus 
• Install Alamut™ Visual Plus and choose the settings directory used by the 

previous version of Alamut Visual Plus 
 

• Accept the End User License Agreement. 
 

 
 

• Provide 
o Your institution code and your license key 
o If any, information relating to your proxy server 
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Once completed, users will only provide their username and password to connect to the 
application. The password will be renewed by the user every 90 days. 

 
 

 
5.4 Getting started: settings 

The Application Settings window includes the following tabs: License, Network, View, Misc. 
(Miscellaneous) 
 
License 

Institution: the code of the institution that 
purchased the license 
 
License Key: the license key of the 
institution 
 
User Name: the name of the connected 
user 
 
Language: Select your preferred 
language (English or French). 
 
Application: Tick the box to 
automatically check for updates. 

 
 
Click Save before leaving the tab. These details will be saved for future log-ins. 
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Network 

To connect via proxy complete the necessary information in the Network tab (this may require the 
input of your IT  administrator).  
 
 
Use Proxy: To use a proxy server, tick the 
Use Proxy box and provide the required 
information to connect to it. 

 
 
View 

Show Selected Transcript on Variant 
Tracks:  select to view the selected 
transcript on the tracks. 
 
Surround protein-level descriptions with 
brackets: select to use brackets in pNomen. 
 
Use systematic exon numbering by default: 
select to use systematic exon numbering by 
default for transcripts. 
 
Default Genome Build (GRCh37 or GRCh38): 
select which genome build you would like to 
use by default. 
 
View table: See part allows you to create 
custom views. For more information, see 
Section 10.2.  
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Miscellaneous 

 
Mouse Wheel: two mouse scroll options are available to define the behaviour of the application 
when using only the mouse wheel or the mouse wheel in combination with the CTRL key. 

 
 
CRAM Settings: CRAM handling in Alamut is based on Samtools. Samtools needs the reference genome 
sequence to decode a CRAM file. Samtools can use either the REF_PATH or REF_CACHE environment 
variables to find reference sequences.  
It uses the MD5 sum of each reference sequence as the key to link a CRAM file to the reference 
genome used to generate it (see also the Samtools man page). You will need to provide the path 
to MD5 reference sequences in the REF_PATH or REF_CACHE field unless you use CRAM files with 
embedded reference sequences. 
For your convenience we have prepared a package of reference MD5 files for GRCh37 and GRCh38 
primary sequences. It is available at:  
http://downloads.interactive-biosoftware.com/CRAM/RefCache.tgz  
 
For instance, if you uncompressed this file to the D:\SAM folder under Windows, the REF_CACHE 
should be:  D:\SAM\RefCache\%2s\%2s\%s 
 
Ask for confirmation before saving variants: select to confirm each time you save a variant into 
a Local Variant Database. 
 
Automatically reload BAM files: select to automatically reload BAM files when opening a new tab 
from a tab with BAM track. 
 
Automatically hide empty datasets: select to automatically hide empty datasets in Private 
Annotation Track when opening a new tab. 
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Profiles 

In this tab, you can activate and manage the Generic Profile feature. This feature allows to 
share configurations among users using a same License Key.  
  
The elements shared through a profile are:  
- the gene shortcuts 
- the preferred transcripts 
- the default assembly 
- the genome area view configuration 
- the Local Variant Databases 
- the Private Annotation Databases 
- the default configuration for BAM visualization 
- the options for splicing visualization 
 
By default, this generic profile feature is disabled, and the configuration of the local installation 
is used. 
 
Note: When a profile is activated, any changes on the elements mentioned above update the 
profile. 
 
Activate Profiles:  
Use this checkbox to enable/ disable the 
feature 
 
Profile Directory:  

• When activating the feature, you must 
choose a Profile Directory. This 
directory is used by the application to 
store the profiles relative files.  

• If the directory does not contain any 
profile linked to your license key, you 
must first create a profile. Profile 
names must be unique within a profile 
directory, regardless of the license key 
of the profile.  

• You can update your profile directory at 
any time by clicking on the Browse 
button. 

 
Selected Profile:  
You can use the combo-box to choose your 
current profile. Use the + and – buttons to 
create or delete profiles. 
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When the profile feature is enabled in the settings tab, you can select the profile you wish to use 
directly from the login dialog. 
 

 
 
Since profile directories are shared by several users, caution must be taken so that multiple people 
don’t edit it simultaneously. 
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5.5 Manual update 

If you wish to update the application manually, please follow these steps:   
- Connect to our extranet page (http://extranet.interactive-biosoftware.com) 
- select the downloads section 
- if available download the latest version. 

 

 
 

Or click on the “Update” button in the left part of the Alamut™ Visual Plus homepage  
 

6. Explore 
6.1  Navigation 

 
 

 
From the top navigation bar, you can open a gene, a genome assembly (GRCh37, GRCh38 or the 
mitochondrial genome) or directly perform a search. This allows you to study either a genomic 
region or a specific variant. 

 

The exploration of a genomic region is done through the genomic view in which all internal and 
external data are gathered and organized in tracks. 
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Information about a specific variant will be displayed into the Variant Panel interface. It gathers 
all external source data () and give access to some other variant oriented features (see section 11 
for more information).  
 

 
 

6.2  Full Genomic Views 

The Genomic Views allows visualisation of all chromosomes and mitochondrial DNA. You can 
visualize structural variants, intergenic and regulatory regions. You can access to a Genomic Views 
by using the ‘GRCh37’, ‘GRCh38’ and ‘Mitochondrial view’ buttons of the navigation bar. 

 

Select the chromosome you wish to study, by clicking on it. The overview of the selected 
chromosome will open. Select a specific chromosomal region and zoom in to view the genes 
available in the selected band. Genes are displayed with name tags along the strand.  
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6.3 Transcript overview 

You can have access to the transcript view from: 
- the genomic views, by clicking on your gene of interest. You can display all transcripts 

related to one gene. The name of the transcript will be displayed in the transcript box.  
 

 

 

 

 

 

 

- the ‘Open gene’ button in the homepage. In the Gene Selection window, to select a gene, 
you can either type a gene symbol or use shortcuts. Shortcuts are configurable. Once your 
gene selected, you will have to select your transcript of interest via the Transcript Selection 
window. The transcript of your selected gene is displayed in the overview, with the exons 
in blue and introns in yellow.  
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Notes 

• The reading direction of the gene (i.e., the DNA strand) can be changed by using the 
forward and reverse direction icons on the toolbar. 

• The transcript and exon nomenclature (if both Systematic and Custom options are available 
for this transcript) can be modified interactively.  

• The view configuration can be modified. You can use different view configurations in 
different tabs. 

• Multiple tabs can be opened showing different genes/transcripts.  
• It is also possible to display all available transcripts simultaneously. 
• When available, the “Transcript selection” tab allows the display of up to four versions of 

one transcript.   
 
Several transcripts can be shown in the interface by exploring options in the transcript track by  
right clicking on the gene name. 
 

 
 

Click on an exon number in the gene overview to zoom in directly and see the nucleotide 
sequence. 
 

 
 

Note: Mismatches between transcript and reference genome sequences can be found. Transcript 
nucleotides are highlighted in red where they differ from the reference genome sequence and the 
tooltip gives a warning message. 
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6.4 GoTo Feature / search bar 

Alamut™ Visual Plus provides a search bar to access the following: 
 
Standard Genetic References  
    

Reference Example 

Official HGNC gene symbol MLH1 

HGNC Id HGNC:7127 

cDNA RefSeq Id NM_000249.3 

Ensembl Transcript Id (mapped to a NCBI RefSeq) ENST00000231790 

LRG Id LRG_1 

Protein RefSeq Id NP_000240.1 

UniProt Id P40692 

Reference SNP Id rs63750891 

OMIM Id OMIM:120436 
 
Genomic, cDNA and protein positions 
 

Reference Example 

Standard gDNA query chr3:g.37050315 

Short gDNA query 3:37050315 

Interval gDNA query  3:36000000-38000000 

gDNA query inside current gene g.37050315 

gDNA query with assembly chr3(GRCh37):g.37059038 

cDNA position query NM_000249.3:c.464 

Short cDNA position query NM_000249.3:464 

cDNA position query on Ensembl Trancript Id 
(mapped to a NCBI RefSeq ENST00000231790:c.464 

NM_000249.3:p.155 NM_000249.3:p.155 

Protein substitution  NM_000249.3:p.Leu155Arg 
 
 
Genomic and cDNA variants 
 

Reference Example 

Query with genomic variation - Substitution  chr3:g.37050315T>G 

Query with genomic variation - Insertion chr3:g.37050315_37050316insTG 

Query with genomic variation - Deletion chr3:g.37050315del 

Query with genomic variation - Delins chr3:g.37050315_7050320delinsAA 
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Query with genomic variation - Duplication chr3:g.37050315dup 

Short query with genomic variation 3:37050315T>G 

Use given assembly Chr3(GRCh37):g.37067317G>A 

cDNA variant NM_000249.3:c.464T>G 

cDNA variant on Ensembl Trancript Id (mapped 
to a NCBI RefSeq) ENST00000231790:c.464T>G 

A given position from the transcript view 4421 
 

§ Note: The “GoTo” bar also enables to search for the gene and the codon position copy-pasted from 
an excel file (e.g. MLH1:c.12 or MLH1:12). 

 
Depending on the query type, Alamut™ Visual Plus may: 
 

• Open a gene and one of its transcripts 
 

 
 

• Open a transcript selection dialog 
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The current transcript selection dialog shows a short list of transcript versions (up to 2 versions). 
Clicking to the link “show extended list of transcript versions” will display the full available 
transcript versions for this gene. 
 

• Open the variant panel 
 

 
 

The variant panel windows allow to display all variant related data into one single interface. For 
more information, see section 11.  
 

• Directly focus on a genomic location 
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Moreover, several lines from NGS output file can be copied and pasted into the search bar.  
 

 
 

 
 
The pasted data then shows up in a variant list. Double clicking on a row will open the selected 
variant in a new window.  
 

 
 

6.5 “Focus On” Feature 

The feature ‘Focus on’ allows you to search for genomic coordinates and more. This feature is 
available from the “View > Focus on” menu. 
 

 
 
This functionality allows the user to find: 

• genomic region 
• genomic position 
• cDNA position 
• protein position 
• variation 
• nucleic sequence 
• protein sequence 
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On the “Find nucleic sequence” box, two options are available to look for nucleic sequences: 
 

- The reverse strand checkbox will allow to look for a nucleic sequence onto the reverse 
strand. 

- The reverse direction checkbox will look for a nucleic sequence following the reverse strand 
direction. 

 
The “Flanking region size” field delimits the region adjacent to the given gene when searching for 
a sequence. 
 

The approximate matching checkbox can be used to find a sequence that are similar to the 
reference sequence allowing to check for any errors, such as mismatches or indels (for more 
information). 
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7. Visualize 
7.1 Viewing BAM/CRAM alignment 

Alamut™ Visual Plus allows to visualize alignment from BAM and CRAM files.  
 
Loading BAM and CRAM files 

 
Two options are available to load alignment files once your gene of interest is opened: 

1. Select menu "File > Open BAM/CRAM File" to load one or more BAM or CRAM files from your 
computer or local network. 

2. Select menu "File > Open BAM from URL" to load a BAM file from a web server. HTTP and 
HTTPS protocols are supported. 

 
Using CRAM files usually requires defining the location of reference sequences. (See Miscellaneous) 
 

 

Notes:  

- One or multiple alignments can be uploaded for each gene.  
- When opening a new gene in a new tab, the BAM file will be automatically uploaded if 

the option “Automatically reload BAM files” is enabled in the “Settings” > “Misc” 
options.  
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BAM Viewer components 
The BAM track includes different components 

 

o Sequencing targets 
o Depth of coverage 
o Reads 
o Variants 

 
When zooming to nucleotide level visualization, the genomic reference sequence is displayed 
above the targets sub-track: 
 

 
 
Hovering over the read will display information related to reads as indicated in the BAM file: 
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Viewing sequencing targets 
In Alamut™ Visual Plus, sequencing targets are supposed to cover current gene's exons with some 
exon-flanking intronic bases (20bp, by default):  
 
You can also load targeted regions from BED files in the BAM track. From the BAM track ‘Options’ 

  or by right clicking on the BAM track. Select "Load BED targets from file" to load a BED file 
from your computer or select "Load BED targets from URL" to load a BED file from a web server. 
HTTP and HTTPS protocols are supported. 

 

 
 
Viewing variants 
Single nucleotide variants (SNVs) are automatically detected where non-reference bases are called 
at a frequency above the 'Allele frequency threshold' defined in the Preferences panel. Jump from 
one SNV to the other by clicking the arrow buttons on the left of the coverage sub-track. 
 

 
 
By default, the VCF is loaded when importing the BAM file if it is located in the same folder with 
same file name.  

From the BAM track ‘Options’   or by right clicking on the BAM track. Select "Load VCF variants 
from file" to load a BED file from your computer or select "Load VCF variants from URL" to load a 
BED file from a web server. HTTP and HTTPS protocols are supported. 
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Visualization options 

BAM preferences are accessible through the BAM track ‘Options’  or by right clicking on the 
BAM track. 
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1. By default, sequencing targets are supposed to cover current gene's exons. This setting 

specifies the number of exon-flanking intronic bases to add to exon-defined targets.  
2. The coverage histogram can either be displayed using a linear scale where the height of 

each bar is directly proportionate to the depth value or using a quadratic scale where low 
depth values are increased, and high depth values are decreased. 

3. Targets are highlighted with red color where coverage depth is below this threshold. 
Besides, detected SNVs are only reported at positions where coverage is above this 
threshold. 

4. Single nucleotide variants (SNVs) are detected where non-reference bases are called at a 
frequency above this threshold. Value given in % (0.2 means 20%). 

5. The navigation arrows of the BAM track will consider single nucleotide variants (SNVs) when 
navigating through variants, when this checkbox is ticked. 

6. Deletions are detected where they appear in reads at a frequency above this threshold. 
7. The navigation arrows of the BAM track will consider deletions when navigating through 

variants, when this checkbox is ticked. 
8. Insertions are detected where they appear in reads at a frequency above this threshold. 
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9. The navigation arrows of the BAM track will consider insertions when navigating through 
variants, when this checkbox is ticked. 

10. When sorted through the “Sort central reads by base” contextual menu option, reads will 
be sorted according to the order defined here (A first, C second, etc in this example). 

11. These settings define the graphical height of reads. 
12. If 'Show all bases' is not checked, then read bases are displayed only if they differ from the 

reference sequence. Some NGS data processing tools "soft-clip" bases at either end of reads 
if appropriate. Checking the 'Show clipped bases' option reveals these bases. This option 
should usually remain unchecked. 

13. Alamut™ Visual Plus does not itself detect PCR duplicates. Reads marked as PCR duplicates 
in the BAM file are removed if this option is checked. 

14. This setting only affects the graphical display of reads, not computations. 
15. Reads with a mapping quality under this threshold are removed. 
16. If this option is checked, then called bases with a Phred score under the specified minimum 

threshold are not displayed. Bases with a Phred score between the specified minimum and 
maximum thresholds are shaded. Bases above the maximum threshold are displayed in full 
color. 

17. Based on insert size values provided in the BAM file, paired reads too distant or too close 
from each other are highlighted if this option is checked. Expected normal insert sizes can 
be expressed as fixed values or as a percentage over the distribution. If the insert size is 
large, denoting a deletion, reads are colored red. If the insert size is small, denoting an 
insertion, reads are colored blue. 

 
Viewing BAM alignment statistics 

Alamut™ Visual Plus computes descriptive statistics from BAM file (depth of coverage and insert 
size). These statistics are computed for the current displayed gene locus. 

Click on the picture (red histogram near options in the BAM track) and, then select either "Depth 
of Coverage" or "Insert Size Distribution" from the menu. 

 

 

 

 

To display the depth of coverage statistics, select "Depth of Coverage" from the menu. 
A table summarizes for the current gene locus, the following statistics: 

- Depth of coverage 1X: the percentage of a region that is covered by at least one read. 
• Depth of coverage based on a user defined coverage threshold: the percentage of a 

region that is covered by at least this coverage threshold. 
• Average, Median and Maximum of the depth of coverage. 

 
These statistics are computed for the following regions: 

• On-Target: targeted region (the region of interest that needs to be investigated by the 
sequence analysis)  
The region is based on the region defined by a user BED file or by the Alamut™ Visual Plus 
targeted region (see ‘Viewing sequencing targets’ section for more details) 

• Off-Target: region outside the targeted region (not investigated by the sequence analysis) 
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• Locus: current gene locus 

 

To display “Insert Size Distribution" (only for paired-end sequencing data), select "Insert Size 
Distribution" from the menu. 
The insert sizes are computed from the reads that are in the current gene locus (displayed in 
Alamut™ Visual Plus) and, then they are plotted as follows. 
The cutoff option allows to choose an insert size interactively by displaying in a graphical format.  
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7.2 Viewing Sanger Electropherogram  

 

Alamut™ Visual Plus allows you to display Sanger Electropherogram (Sequencing) data by opening 
a new track through the “File > open Sanger file” menu. 

 

A pop-up will appear where you can select the exon that matches the Sanger sequence you wish 

to align. Alamut™ Visual Plus is also able to select the best suited exon automatically.  
If the Sanger file you wish to load, covers multiple exons or intronic regions, you can manually 
select the genomic region to be considered. Alamut Visual Plus will then run its alignment 
algorithms considering the nucleotides located inside the specific area. 
 

 
 

The Sanger track shows different components 
 

 
 

1- Quality scores are displayed in bars. 
2- Reference sequence. The reference sequence displayed is always the forward sequence. 
It can be hidden via the ‘Options’ menu  
3- Sanger reference. If the sanger sequence has been aligned with the forward sequence, 
it will be displayed with a blue background; if it has been aligned with the reverse sequence 
the background will be green. When a substitution is detected, it is highlighted in red. A 
deletion is indicated by a ‘-‘ and highlighted in red. An insertion is indicated by an arrow.  
4- Electropherogram. The display can be scaled with the ‘Scale’ button.  
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5-The quality threshold. By default, the threshold is set at 20. The user can customize the 
threshold. When it shows a quality score lower or equal to the indicated ‘Q-value’ in the 
track, the bar in the quality scores sub-track is displayed in orange. 
6- Print Sanger track. 
 

A Sanger variant report can be exported form the Sanger track. ‘Options’ menu  > Export variants 
 
When hovering the nucleotide in the Sanger track, you can see the nucleotide and its coordinates 
as following: 
 

 
 

7.3 Viewing sequence-based annotation files (BED, GFF)  

 
Alamut™ Visual Plus supports the visualization of annotations in BED, GFF version 2/GTF, GFF 
version 3 in the Private Annotations Track. By default, this track is not visible. To display it, you 
need to enable it in the View tab of the Application Settings window. 
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Automatic Import 
 
To automatically import sequence-based annotation files into a private annotation track, you will 
need to create a Private Annotation Database. The workflow to create a Private Annotation 
database is described in Section 8.2.. 
 
Once the database created, you need to store all the files you want to import in the private 
annotation database folder. Then, open Alamut Visual Plus and open the Private Annotation 
Database window via Menu > ‘Private Annotations’ > ‘Private Annotation Databases’. Check the 
“Current Database” checkbox to use this database in the Private Annotation Track and the 
“Automatic Files Import” checkbox to trigger the automatic load of files.  
 

 
 
Your sequence-based annotation files will now be automatically loaded each time you open a new 
tab in Alamut Visual Plus. 
 
Manual import 
To import sequence-based annotation files, open the ‘Options’ menu  of the Private Annotation 
Track. You can click on ‘Import Files’, choose the files you want to import and validate. You can 
import several files at once. If you want to import all the sequence-based annotation files of a 
folder, you can click on ‘Import Folder’, choose the folder, and validate. 
 

 
 
Each file will generate at least one dataset and the sub-track will appear in the track. As for 
manually created datasets, right-clicking on a dataset label will open a context menu.  
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This menu contains two items to manage how the private annotations are displayed in the 
associated sub-track: 

• Full: change the display to view all segments in full mode 
• Squish: change the display to view all segments in squish mode 

 
Data imported from sequence-based annotation files cannot be edited so a dataset created by an 
import cannot be renamed or erased.  
  
You can visualize the information of the imported private annotations by double-clicking on it or 
by using its context-menu. The information of imported private annotations cannot be edited. 
 
Note: Data from sequence-based annotation files are loaded into Alamut Visual Plus in read only 

mode. If you need to update them, update the source file and load it again into Alamut 
Visual Plus.   
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8. Annotate 
8.1  Variant Databases 

 
Alamut™ Visual Plus allows you to annotate and store variants. Click on menu > Variant > Local 
Variant Databases. 

 

 

 
By default, a local database called “Alamut” is available, you can use it to store your internal 
variants.  
 
By clicking on ‘New’ in the Local Variant Databases, a new tab will appear ‘New Database’. You 
can define a new database by selecting a path, adding a name and a description.  
You can easily switch from one database to another. 
 

 
 
The basic variant database functionality implementation allows to store databases on each user's 
computer, or on a shared folder. When variants are stored in a shared file system, caution must 
be taken so that two people don't edit simultaneously. 
 

 

If you want to work on an already existing database, you can add it to your workspace by clicking 
on ‘Add Existing Database’. If this database is shared between users, tick the ‘Shared Database’ 
checkbox.  
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Note: We do not recommend sharing databases between different versions of Alamut Visual Plus. 
If you do use the shared database feature, all users should switch to a new version of Alamut 
Visual Plus at a same time. 
  
When exploring a genomic region, your internal variants will be displayed in a specific track (one 
for each Local Variant Database). For each Local Variant Database, you can use the ‘Display in 
track’ column to choose in which ‘View configuration’ the associated track should appear (see 
section 10.2 to create or edit a view configuration). 
 

 
 
Alamut™ Visual Plus also enlists and navigates through all internal variants for the current gene 
by selecting a database and clicking on ‘Explore/Export’ button in the ‘Local Variant Databases’ 
tab.  
 
Variants will be displayed in a new tab ‘Variant exporter’. You can display different options as 
showed in the ‘Row filters’ and ‘Column filters’ fields. You can scroll down/up and right/left to 
explore your internal variants. 
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When working on a shared database, you may need to manually refresh your variants to retrieve 
changes made by your coworkers. To do so, use the ‘Refresh Variants’ item of the ‘Variant’ 
menu. 
 

 
 

The manual refresh may be needed when you want to retrieve changes on a region for which 
Alamut Visual Plus has already loaded database data (because you are working or have worked 
on it). 
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8.2  Private Annotation Databases 

 
Private annotations functionality enables you to manually define sequence-based annotations. 
This feature is available on a dedicated track: the “Private Annotation Track”. By default, this 
track is not visible. To display it, you need to enable it in the View tab of the Application Settings 
window. 

 
 
Creating and managing private annotation databases 
 
Private annotations are stored in a dedicated database. To manage your private annotation 
databases, click on menu > Private Annotations > Private annotation Databases. 
 

 
 
The Private Annotation Databases window lists the existing databases available for visualization 
and annotation. 
In the Private Annotations Track, you will be able to see the content of one of your private 
annotation databases at a time. You can choose which database you wish to display by using the 
‘Current Database’ checkbox.  
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To create a new database, click on ‘New’ button. A new pop-up will appear. You can define a new 
database by selecting the path of the newly created database, a name, and a description. 
 

 
 
The basic private annotation database functionality allows to store databases on each user’s 
computer, or into a shared folder. When private annotations are stored in a shared file system, 
caution must be taken so that two people don’t edit the private annotations, simultaneously. 
 
If you want to work on a database created by another user, you can add it to your workspace by 
clicking on ‘Add Existing Database’. Then, tick the ‘Shared Database’ checkbox.  
 

 
 

Note: We do not recommend sharing private annotations databases between different versions of 
Alamut Visual Plus. If you do use the shared database feature, all users should switch to a new 
version of Alamut Visual Plus at a same time. 
 
When working on a shared database, you may need to manually refresh your variants to retrieve 
changes made by your coworkers. To do so, use the 'Refresh Private Annotations' item of the 
'Private Annotations' menu. 
 

 
 

The manual refresh may be needed when you want to retrieve changes on a region for which 
Alamut Visual Plus has already loaded database data (because you are working or have worked 
on it). 
 
Import Private Annotations from Alamut™ Visual 
 
Private Annotation files from Alamut™ Visual (.apa) can be imported into the Private Annotation 
Databases of Alamut™ Visual Plus. To do so, open the Private Annotation Database window via 
Menu > ‘Private Annotations’ > ‘Private Annotation Databases’. Select the database you want to 
import the private annotations into. Click on ‘Import’ and select the file you want to import.  
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9. Import Variants 

 
Supported file format 
Alamut™ Visual Plus can import variants from external sources into local variant databases. The 
imported variants will be stored into the selected Local Variant Database (LVD). 
 
Successfully imported variants are saved as standard Alamut™ Visual Plus internal variants and can 
then be handled like other internal variants. 
Alamut™ Visual Plus can import variant annotations from TSV (Tab-separated values) formatted 
files as Variant Calling Format files (VCF). 
 
Note that for Alamut™ Visual users, the same workflow can be used to import .mut files and .txt 
variant files that may have been exported from Alamut™ Visual. 
 
 

9.1  Import variant from an excel file or TSV format 

Alamut™ Visual Plus accepts a tabular import file containing variant descriptions and annotations. 
Import files must follow a precise format that is most easily created using a spreadsheet 
application like Excel. Here is an example. The column order must be strictly observed.  
 
The header line (with column labels) is mandatory. Columns must be named as in the example in 
below: 
 

 
 
The following sets of columns must be populated to define the variants: 
 

• Assembly 
• Chromosome 
• gNomen 

or 
• Gene 
• Transcript 
• cNomen 

 

Assembly — GRCh37 or GRCh38. 

Chromosome — chrN or N, where N is the number of the chromosome (or X or Y, or MT) 

Gene — The official symbol of the gene carrying the variant. 

Transcript — The RefSeqDna of the transcript used to describe the variant.  

gNomen — The gDNA-level variant description, using the HGVS nomenclature.  

cNomen — The cDNA-level variant description, using the HGVS nomenclature.  

Assembly Chromosome Gene Transcript gNomen cNomen Type pNomen Coding effect Evidences (ACMG) Classification Notes Occurrence ID Family ID Phenotype RNA Analysis HPO IDs Comment
GRCh37 2 MSH2 NM_000251.2 g.47630335C>A c.5C>A Substitution p.(Ala2Glu) Missense PM1,PM2,PP3 Likely Benign This is a note relating to this variant 1 123 Adam+

GRCh37 2 MSH2 NM_000251.2 g.47630347_47630350del c.17_20del Deletion p.(Lys6Argfs*57) Frameshift Likely Pathogenic 2 456

GRCh37 2 MSH2 NM_000251.2 g.47657084A>C c.1276+4A>C Substitution p.? Undefined Significance
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Type — The variant type: Substitution, Deletion, Insertion or Duplication. 

pNomen — Consequence of the variant at the protein level. 

Coding Effect — Missense, Start loss, Nonsense, Stop loss, Frameshift, In-frame or Synonymous. 

ACMG evidences — ACMG rules, separated by coma. 

Classification — Variant classification as per the ACMG guidelines :  

• Benign 
• Likely Benign 
• Uncertain Significance 
• Likely Pathogenic 
• Pathogenic 

If no value is supplied here, " Undefined Significance" is assumed 

Notes — Comments associated to the variant. Free content field. 

Occurrence ID — Free content field. 

Family ID — Free content field. 

Phenotype — Free content field. 

RNA Analysis — Free content field. 

HPO IDs — Human phenotype ontology IDs 

Comment – Comment associated to the occurrence. Free content field. 

 
9.2  Import variant from a vcf file 

Standard VCF files can be imported. Fields are #CHROM POS ID REF ALT QUAL FILTER INFO FORMAT 
Only CHROM, POS, REF and ALT are used to set up the variant. 
 

9.3 Important variant from an existing Alamut database 

Variant files from Alamut™ Visual (.mut) can be imported into the Local Variant Databases of 
Alamut™ Visual Plus.  
 

9.4 Import process 

To import variants from an import file as described above, in Alamut™ Visual Plus:   

Menu > 'Variants' > ‘Local Variants Databases'  

Select a line (Local Variant Database) where the variants will be stored and specify the import 
file you have by clicking on ‘Import’.  
 

 
 
Alamut™ Visual Plus will analyse the imported file and report valid and invalid entries based on 
the format.  
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Only validated variants (shown in green) will be imported to the Local Variant Database.  
 

 
 
Notes: 

• The import process can be managed without opening a specific gene or transcript from the 
homepage of Alamut™ Visual Plus 

• The import process can also be managed when a gene and a transcript are already selected 
and opened.  

• For VCF and TSV (with gNomen) import files, variants outside of the gene locus will also be 
processed. 

 
 
Handling conflicts: 
 
When importing variants into a Local Variant Database, some of the variants to import might 
already exist in the database. 
 
To handle possible conflicts, if the variants to import already exist into the database, three 
options are available: 
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• Do not import already existing variants – conflicting variants will be ignored during the 
import process 

• Overwrite variants if already exist – in case of conflicts, the variants to import will replace 
the existing ones 

• Update existing variants and add history entry – variants get normally imported, a new 
entry will be added to the variant history to track the updates 

 
 

10.  Evaluate 
10.1 Visualize Alamut variant sources and databases 

 
Alamut™ Visual provides a convenient access to several databases of known variants and public 
databases. 
 
Population Frequencies Database 
 
Population frequencies data are displayed in the ‘Allele Frequency Databases’ track. 
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Hovering one variant will show information from different databases when available. Right clicking 
on a variant opens the official website of the selected source. 

 

          
 

More information from external databases is available in Alamut™ Visual Plus by right clicking and 
selecting the variant’s gnomen: 
 

 
The variant panel will pop-up with more information in the ‘External databases’ section. For more 
information see section 11.1. 
 
You can configure this track to filter its variants, see section 10.3 for more information. 
 
ClinVar 
 
Alamut™ Visual Plus displays ClinVar variants in a dedicated track 
Variant background colors are based on the clinical significance provided by ClinVar submitters.  

a. Red for pathogenic variants 
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b. Orange for likely pathogenic variants 
c. Light Green for likely benign variants 
d. Green for benign variants 
e. Gray for variants of an uncertain significance 
f. White for Unclassified variants 

 
If multiple SNVs are reported at the same position, a tooltip pops-up to show significance for both 
variants.  

 
You can configure this track to filter its variants, see section 10.3 for more information. 
 
Right-clicking will show the link to the ClinVar website and to the Variant panel where information 
from ClinVar is displayed. 
 
COSMIC 
 
Alamut™ Visual provides access to COSMIC variant in a separate track.  
 

 
 
You can configure this track to filter its variants, see section 10.3 for more information. 
 
Right clicking on a mutation opens the variant panel with information and directs you to the 
COSMIC website. 
 
UniPROT 
 
The “UniProt” track displays variants set at protein level from UniProt. You can see the amino 
acid information and the disease involvement by hovering over a variant on the track. This 
information is also available in the variant panel. 
 

 
Protein Domain 
 
The “Protein Domains” track displays the domain information from InterPro (via Ensembl).  
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Database of Genomic Variants 
 
The track displays the structural variations in the genome via the DGV database.  
 

 
 
Repeat Masker 
 
The Repeat Masker track displays the repeat DNA regions identified by the Repeat Masker tool.  

The regions are displayed by type: 

• SINEs  
• LINEs  
• DNA elements (DNA)  
• Simple Repetitions (Simple Repeat) 
• Low Complexity 
• Satellite Elements (Satellite) 
• Small RNAs (RNA)  
• Not Classified (Unknown) 
• Other 

 
 
Orthologues alignment 
 
The Orthologues track displays alignments of protein orthologue from the Ensembl database, ICAR 
or IBC (In-house). These alignments show the conservation of amino acids across different species.  
 

 
 

By default, orthologues aligned and displayed in Alamut™ Visual Plus are taken from the Ensembl 
Compara database.. 

References: 

• We would like to express our thanks to the Genetic Cancer Susceptibility Group at IARC for 
their kind help in defining our alignment protocol.  

• Tavtigian, SV., Greenblatt, MS., Lesueur, F., Byrnes, GB. (2008). In silico analysis of 
missense substitutions using sequence-alignment based methods. Hum Mutat.11 : 1327-36 

• Tavtigian, SV., Oefner, PJ., Babikyan, D. et al (2009). Rare, evolutionarily unlikely missense 
substitutions in ATM confer increased risk of breast cancer. Am J Hum Genet. 85 : 427-46.  
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• Deforche A., Blavier A. (2010). Systematic Building of Multiple Protein Alignments for 
Variant Interpretation Human Genome Meeting poster. 

 

Genomenom Mastermind 
 
Mastermind® by Genomenon® is a search engine with a comprehensive collection of genomic 
evidence and a user-friendly database. More information about Genomenon® is available 
at https://www.genomenon.com/tutorials/. 
 
Mastermind® visualization can be activated in the “Settings > View” tab for each view 
configuration. 
 
Alamut™ Visual Plus displays Mastermind variants in the dedicated “Genomenon Mastermind Cited 
Variants Reference” track. Variants are reported from Cited Variants Reference (CVR), equivalent 
to a Variant Call Format (VCF) file. The CVR contains a count of articles associated with each 
variant, along with a deep link into the related Mastermind UI. More information on CVR 
at https://www.genomenon.com/cvr/. 
 
If multiple SNVs are reported at the same position, a number indicating the substitutions occurring 
at this position. A pop-pup at the top of the position will display the different variations.  
Right-click on a variant to display links to the variant panel and to the Mastermind® website.  
A field in the variant panel displays the number of articles, including the three MMCNT values. 
 

Mouse over on a CVR variant to pop-up a tooltip displaying the gnomen and the three MMCNT 
values: 

• MMCNT1: cDNA-level exact matches 
The number of articles mentioning the variant at the nucleotide level in title/abstract or 
full-text. 

• MMCNT2: cDNA-level possible matches 
The number of articles with nucleotide-level (from 1) and protein-level matching with not 
specified cDNA-level change (articles could refer to this nucleotide-level variant but there 
is insufficient data to determine conclusively). 

• MMCNT3: same biological effect matches 
The number of articles citing any variant with the same biological effect as the 
considered variant. This includes MMCNT1 and MMCNT2 articles plus those with 
alternative cDNA-level variants that result in the same protein effect. 
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BRCA Exchange 
 
The BRCA Exchange database is available in a specific track while opening BRCA1 and BRCA2 
(https://brcaexchange.org/help). 

 
 
Hovering on the variant will give you some insights on the pathology stored in BRCA Exchange 
database. This information is also available in the variant panel through the BRCA Exchange 
section and in the report. 
 

 
 
Gene External Features 
 
OMIM®, gnomAD scores (pLI, LOEUF), BRIDGES and MANE information are also reported in Alamut™ 

Visual Plus in the genomic view.  
  

 
 
Clicking on one of the three blue buttons at the top right of the genomic view (gnomAD SCORES, 
OMIM® or BRIDGES) will display a dialog window: 
 

 
 

 
BRIDGES dialog window displays the following scores: 
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- Pop p-value_MSV: P-value for Missense Variant  and breast cancer 
- PTV Odds Ratio (95% CI): Odds ratio for Protein-truncating variant  and breast cancer. Please note that 

for PTVs, the risks apply to every variant that ClinVar calls “pathogenic” 
- Pop p-value_PTV: P-value for Protein-truncating variant and breast cancer.  
- Missense Odds Ratio (95% CI): Odds ratio for Missense Variant and breast cancer. Please note that for 

missense variants ClinVar assertions were not used for most genes, except BRCA1, BRCA2, TP53 
- BFDP: Bayesian false-discovery probability	

 

 
 

 
Double clicking on OMIM-Id or on a phenotype row will open the corresponding gene or phenotype 
in the OMIM® web page:  
 

 
The MANE categorisation is also available in the transcript selection tab. 
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10.2 Display and Configure specific tracks 

 
View Configuration 
 
The View tab in the Application Settings window allows to edit the default view configuration or 
to create a custom one. 

 
 

In the Default view configuration, all tracks are displayed. By creating custom views, you can 
check/uncheck the tracks you want to see/hide. You may also change the tracks display order via 
drag and drop.  
 
Note: The Local Variant Database track does not appear in the list of tracks. You can configure in 
which view configuration a Local Variant Database track appears via the Local Variant Databases 
window, see section 8.1 for more information. 
 
You can define a view as default configuration by selecting it and by ticking the ‘Use as default 
configuration’ checkbox. The view will then be used by default when a new genomic view is 
opened. 

 
 
You can change the view configuration used by a genomic view at any time via the ‘View 
configuration’ combo box. 
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Specific Track Configuration 
 
Applying filters to a specific track is a convenient way to filter the variants displayed by a given 
data source. 
It can be done while editing a view configuration or you may open the view configuration window 
by clicking at any time on the ‘Options’ button  of the track to filter. 
 

 
 
Filters can be set for 3 tracks: 
 

1. Population Frequencies Database Track: you can select or deselect data sources and 
choose filters. 

 

 
 

2. Clinvar Track: you can filter variants based on ‘Review Status’. 
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The Review status numbers are defined as follows: 
• 0: No submitter provided an interpretation with assertion criteria (no assertion criteria 

provided), or no interpretation was provided (no assertion provided). 
• 1: At least one submitter provided an interpretation with assertion criteria (criteria 

provided, single submitter) or multiple submitters provided assertion criteria but there are 
conflicting interpretations in which case the independent values are enumerated for clinical 
significance (criteria provided, conflicting interpretations). 

• 2: Two or more submitters provided the same interpretation (criteria provided, multiple 
submitters, no conflicts) 

• 3: Reviewed by expert panel. 
• 4: Practice guideline. 

 
 

3. COSMIC Track: you can filter variants based on the ‘Tissue’ criteria. 
 

 
 
 

10.3 Create variants 

You can manually create variants either from the 'Variants' menu, or from a nucleotide selection 
in the genome or transcript track and its associated context menu (by right-clicking inside the 
selection). 

 

        
 

Once you have specified variant basic properties (position and type of change), the ‘Variant Panel’ 
(annotation window) opens in a new tab. In the ’Variant properties’ you can choose to apply your 
variant at the genome or transcript level.  
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This will open a Variant Panel where you can study your variant and save it in your Local Variant 
Database. For more information on the Variant Panel, see section 11. 
 
Notes : Application of HGVS recommendations 

• Alamut™ Visual Plus enables the user to check the variant with Mutalyzer Name Checker or 
VariantValidator from the annotation window 

• The HGVS recommendations for the description of sequence variants implies that for all 
descriptions the most 3' position possible is arbitrarily assigned to have been changed. 
Application of this recommendation can make variant entry in Alamut™ Visual Plus 
ambiguous, since the new variant entry may result in a variant located at a different 
position. Thus, both mutated sequences – the one entered and the resultant – should be 
identical. 

• For gNomen, the 3’ rule is always applied for a gene on the forward strand of the DNA and 
for cNomen, the 3’ rule is applied at the cDNA level. Thus, for a gene encoded on the 
reverse strand, the cDNA-level variant positions will not always map to the same 
genome position as sown in gNomen (this is not compliant with HGVS (For Alamut Visual 
users: this is handled differently as compared to Visual. In the Variant Panel > Variant 
Features > Genomic Level > alternatively; it is indicated the HGVS nomenclature as 
referred to Visual) 
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You can change at any time the ‘Transcript’ and the ‘Local Variant Database’ of your variant by 
using the menu at the Top of the ‘Variant Panel’: 

 

 
 

Note: In a same Local Variant Database, you cannot save a same variant with different 
transcripts. 

 

10.4 Create Private Annotations 
 

To be able to create private annotations, you first need to create a Private Annotation Database 
and to select it as the current Private Annotation Database. For more information, see "Creating 
and managing private annotation databases" part of Section 8.2. 
 
Creating and managing datasets 
 
Private annotations are organized in sub-tracks called datasets. To create custom datasets, you 
can use the ‘Options’ menu  of the Private Annotation Track or the context menu of a 
nucleotide selection in the Private Annotation Track (by right-clicking inside the selection).  
 

You need to have a database selected as your current private annotation database to 
be allowed to create custom datasets.  

 

 

 
 
Clicking on ‘Add Dataset’ will open a new pop-up where you can specify the name of your new 
dataset. Dataset names must be unique among a database. Clicking on ‘Ok’ will create the dataset 
and the new sub-track will appear. 
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Right-clicking on a dataset label will open a context menu. This context menu allows the 
following actions: 

• Transparency: the private annotations are displayed with semi-transparent colours when 
this option is checked and with plain colours otherwise  

• Hide: hide the dataset from the track 
• Hide Others: hide the other datasets from the track 
• Up: move up the dataset 
• Down: move down the dataset 
• Rename: rename the dataset 
• Clear: delete all annotations of the dataset 
• Erase: delete the dataset (from the track and from the database) 

 

The ‘Options’ menu  of the Private Annotation Track contains items to manage the group of 
datasets: Show All to show all datasets when some have been hidden previously and Erase All to 
erase all the datasets. 
 
Creating and managing Private Annotations 
 
A new private annotation can be manually created from the context menu associated to a selection 
of nucleotides. The nucleotide selection can be done in the Private Annotation, the Genome or 
the Gene tracks.  
 

You need to have a database selected as your current private annotation database and 
to have at least one dataset in your current database to be allowed to create private 
annotations. 
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Clicking on ‘Make sequence annotation…’ will open a new pop-up where you can specify the 
properties of your private annotation:  
 

• Dataset: the dataset/sub-track 
• Assembly: the assembly of the annotated sequence. A private annotation is visible only on 

the assembly to which the sequence has been mapped. When updating the assembly, the 
positions ‘From’ and ‘To’ will be automatically mapped to the new assembly. 

• From/To: origin and end of the annotation. The strand is automatically set according to 
the strand that has been used to select the nucleotides in the track. The length and the 
sequence are automatically computed. 

• Name: name of the private annotation. Private annotation names have to be unique among 
a dataset 

• Arrow: the arrow initialized according to the strand of the private annotation 
• Score 
• Color 
• Comment 
• External link: web link or link to an internal document 

 

Clicking on ‘Save’ will create the private annotation and it will be visible in the sub-
track to which it belongs.  
 

 
 
Then, to edit the private annotation information, you can either double-click on the 
private annotation track or use its context-menu. 
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10.5 Variant Interactive Filtering 

 
The Variant Interactive Filtering feature allows the user to visualize information on 
variants visible in a Local Variant Database track and to create filters on them. 
 

 
 
To activate the Variant Interactive Filtering feature, click on  icon in the Local 
Variant Database track. The feature can be activated on a single database at a time. 

 
 
Once the Interactive Filtering feature is enabled, a table is displayed at the bottom 
of the screen. This table displays the information of the variants currently visible in 
the Local Variant Database track. The title of the filtered track is suffixed by " - 
filtered" and its background is blue. 
 
By default, the following information are displayed in the table: Assembly, 
Chromosome, Gene, Transcript, gNomen, cNomen, Type, pNomen, Coding effect, 
Evidences (ACMG - user defined), Classification, Notes. 
 
The variants displayed in the table are automatically refreshed while you navigate 
through the genome. You can focus on a variant by clicking on a line of the table. 
 
You can configure the table by using the  icon at the top left of the table. Two 
actions are available to either filter columns or rows of the table. 
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Filter Columns 
When clicking on "Filter columns", a dialog pops-up where you can select which 
information you want to display in the table. 
 

 
To add columns via the "Column" list: 
- select columns and clicking on "Add" button. 
- click on "Add All" button. 
- double-click on a column. 
 
To remove columns via the "Active Columns" list: 
- select columns and clicking on "Remove" button. 
- click on "Remove All" button. 
- double-click on a column. 
The "Reset to default" button resets the table to its defaults state (containing the 
default columns only). 
 
Filter Variants 
When clicking on "Filter variants", a dialog pops-up where you can create filters on 
variants displayed in the table and in the track. 
 
You can create filters only for information/columns currently displayed in the table. 
You can create at most 1 filter by column. 
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You can create new filters via the left side of the dialog. A filter is defined by the 
following information: 

- the column to apply the filter on. 
- a value or a list of values. 
- an operator used to compare the variant value(s) with the filter value(s). 

 
The way to define values depends on the type of data of the column. For numeric 
column, you must manually fill values whereas for other columns you have to choose 
the values among a list. 
 
The available operators depend on the type of the data of the column. For numeric 
columns the available operators are: =, <=, >=, ∈, ∉. For other columns, the only 
valid operator is =. 
 
Once all the filter information filled, you can click on "Add Filter" button to add the 
filter to the table. 
 
The list of "Active Filters" is displayed on the right side of the dialog. You can remove 
filters from the table by: 
- selecting filters and using "Delete" button. 
- clicking on "Delete All" button. 
 

11. Interpret 
 
The Variant Panel gathers all information needed for variant interpretation in the 
‘Annotation’ and ‘Splicing’ tabs. 
 
The ‘Annotation’ tab first contains a ‘Variant Features’ section where all variant 
nomenclature information (gDNA, cDNA, protein consequence, etc…) are displayed. 
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11.1 External Sources 

 
To view the up-to-date list of data sources integrated into Alamut™ Visual Plus, go 
to “Help > Data Sources”. Database versions of each source is also specified in the 
Variant Panel.  

 

 
 
The ‘Annotation’ tab of the Variant Panel contains an ‘External Databases’ section 
which gathers all the data sources available for the given variant. 
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Note: The review status displayed in the variant panel are reported from COSMIC as 
following: 

• The status "NA": “Not specified”, “Variant of unknown origin”, “Previously 
observed” 

• The status “No”:  "Reported in another sample as germline", "Confirmed 
germline variant" 
The status “Yes”:  "Reported in another cancer sample as somatic", 
"Confirmed somatic variant"  

 
The ‘Annotation’ tab also contains a ‘Gene Features’ section which contains some 
extra scores computed at the gene level (gnomAD scores, OMIM, BRIDGES). 
 

 
 
Notes: 

- To include OMIM® phenotypes in the report, you may tick the “Add to Report” 
checkbox 

- Double clicking on an OMIM® row will open the corresponding OMIM® web 
page.  
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11.2 ACMG-AMP standards and guidelines 

ACMG-AMP Variant Interpretation Standards and Guidelines Support (Richards et al., 
2015. Genet Med 17:405–424) are available in Alamut™ Visual Plus.  
 
The ACMG guidelines support is available in the Variant panel > ‘Annotation’ tab > 
‘Pathogenicity Class’ section. The suggested classification is displayed under ‘ACMG 
standards and guidelines’.  
 
By clicking in ‘Show details’, the user has access to definitions of categories as 
reported in Richards et al., 2015.  
 

 
 
When data are not available in Alamut database to support evidence (such as 
experimental results):   

- ‘Not available’ is displayed in the ‘Suggested’ field 
- A blank/empty evidence field indicates that Alamut Visual Plus does not 

support these ACMG criteria 
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11.3 Splicing Prediction Tools 

 
Alamut™ Visual Plus includes a splicing module integrating several prediction 
algorithms and splicing prediction data: 

 
a. Splicing signals: 

 
• SpliceSiteFinder-like (donor, acceptor, branchpoint): Alamut™ Visual Plus 

uses the matrix described by Zhang et al. (1998) for branch points and the 
algorithms described in Shapiro et al. (1987). 

• MaxEntScan (donor, acceptor): MaxEntScan splice site datasets and 
algorithms are fully integrated in Alamut™ Visual Plus, and reports scores from 
the Maximum Entropy Model. 

• GeneSplicer (donor, acceptor): University of Maryland CBCB  
• NNSPLICE (donor, acceptor): (the Berkeley Drosophila Genome Project) 

Alamut™ Visual Plus reports scores from NNSPLICE 0.9. 
• Known constitutive signals (donor, acceptor): Alamut™ Visual Plus reports in 

the splicing module each occurrence of the 9-mers (3 exonic + 6 intronic 
nucleotides) found in the donor subset of human constitutive exon/intron 
junctions, and each occurrence of the 6-mers (4 intronic + 2 exonic) found in 
the acceptor subset. Acceptor 6-mers are reported only where at least 6 of 
the 8 upstream nucleotides are pyrimidines. 

• Mercer high confidence branchpoints: 
 

b. Exonic Splicing Enhancers (ESE) binding site detection: 
 

• ESEFinder: ESEFinder matrices are embedded in Alamut™ Visual Plus to 
perform the computation provided on the ESEFinder web site. 

• RESCUE-ESE: The set of human hexamers available from the RESCUE-ESE web 
site is embedded inside Alamut™ Visual Plus  

• EX-SKIP: The EX-SKIP tool is available, through the Alamut™ Visual pre-filled 
form functionality, computes the number of RESCUE-ESEs, FAS-ESSs, 
PESEs/PESSs, neighbourhood inference and EIE/IIEs for each segment. 

 
c. Splicing module: 

 
The splicing module includes: 

• The variant annotation window with automatically computed splicing predictions 
at the nearest junction for MaxEntScan and SSF predictors. 

• The splicing prediction algorithm NNSPLICE from fruitfly.org partially integrated: 
it can be interrogated from Alamut™ Visual Plus through the Internet and its 
results are displayed seamlessly in the graphical interface. 

• The splicing report that provides scores for each predictor in a tabular format.  
 
Using the splicing window:  
To open the splicing window:  

- click on the 'Splicing’ tab in the variant panel 
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- The window displays the reference (wild-type) and mutated sequences and 
predictions are reported above and under each one.  

- Exons are represented with blue boxes. 
- Hits from SpliceSiteFinder-like, MaxEntScan, NNSPLICE and GeneSplicer are 

displayed as blue vertical bars for 5' (donor) sites, and as green vertical bars 
for 3' (acceptor) sites. The height of each bar is proportional to the maximum 
possible score computed by the corresponding algorithm.  

- Known constitutive signals are displayed as small blue (5') or green (3') 
triangles, close to the sequence letters.  

- Mercer et al. high confidence branchpoints are displayed as red triangles in 
the Branch Points sub-track of the Reference Sequence. 

When moving the mouse over each vertical bar or triangle, a tooltip appears with 
the corresponding score. You can display score numbers for each hit bar by just 
clicking the bar itself. 
 

 

 
The region for which predictions are computed is centered on the position of the 
variant. You can navigate before and after this region by clicking and dragging the 
mouse. 
Use the “Options” menu to select which predictions to display and to modify 
thresholds. 
 

- To reveal differences between wild-type and mutated scores, click on 
the 'Highlight Differences' button. Unchanged hits get dimmed, while scores 
are displayed beside those that differ. 

- To reveal differences between wild-type and mutated scores, click on 
the 'Highlight Differences' button. Unchanged scores get dimmed, 
while score numbers are displayed beside those that differ. 
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- To display ESE predictions, click the "ESE Predictions" button. ESE hits from 
ESEfinder are displayed above each sequence, and RESCUE-ESE hexamers are 
drawn under them: 
 

 

 
- To launch the EX-SKIP tool: go to "ESE predictions" and click the "EX-

SKIP" button. The pre-filled web form of the EX-SKIP tool is displayed in a new 
window. Input sequences are created as follows by Alamut Visual Plus: only 
exonic sequences are considered with up to 30 exonic nucleotides before or 
after the variant position within the exon. 

- To generate a tabular report of splicing signals predictions, click 
the 'Report' button. By right clicking on the report, you can save it in your 
computer. The flanking region threshold can be set by the user via the “Splicing 
predictions options” tab. The default is fixed at 200. 

- The user can select displayed splicing methods from the “Options” menu. 
Thresholds for splice site predictors can be saved as user-defined parameters.  
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11.4 Missence Prediction 

 
Alamut™ Visual Plus provides automatically computed missense predictions done by 
Align GVGD and SIFT, based on orthologues alignments (see section 10.1.8).  
With the genome build GRCh38 available in Alamut™ Visual Plus, some orthologues 
alignments coming from ENSEMBL Compara have been updated and may lead to 
different predictions that those described for the same genes/transcripts for 
GRCh37.  

Currently, automatically computed predictions are provided for Align GVGD, SIFT,  
MutationTaster, Polyphen 2 and CADD. 

Automatically computed predictions are available in the variant panel. The 
‘Annotation’ tab of the Variant Panel has a ‘Missense Predictions’ section which 
contains the in-silico missense prediction scores from multiple tools. Clicking on 
the predictor name will bring you to the missense predictor website. 
 

 
 
This section describes how automatically computed missense predictions are 
provided in Alamut™ Visual Plus: 
 
Align GVGD 
Align GVGD predictions are computed using the orthologue alignment provided by 
Alamut™ Visual Plus for the gene under study (See section 10.1.8). 
Align GVGD scores interpretation are available here. 
Current version for precomputed predictions: Align GVGD Tavtigian et al. (2007) 
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CADD  
CADD prediction is a tool for scoring the deleteriousness of single nucleotide variants 
as well as insertion/deletions variants in the human genome.  
CADD scores interpretation is available here.  
Current version for precomputed predictions: CADD from CADD website  
 
MutationTaster 
MutationTaster predictions are computed using the mapping between NCBI RefSeq 
and Ensembl Transcript Ids available in Alamut™ Visual plus. 
MutationTaster scores interpretation are available here. 
Current version for precomputed predictions: MutationTaster2 from MutationTaster 
website 
 
PolyPhen-2 
Alamut™ Visual Plus displays precomputed scores from WHESS.db database. You may 
observe differences between the precomputed scores and the scores obtained via 
Polyphen-2 main query page between two updates of WHESS.db. 
Current version for precomputed scores: WHESS.db for PolyPhen-2 website. 
 
SIFT 
SIFT predictions are computed using the orthologue alignment provided by Alamut™ 
Visual Plus for the gene under study. See SIFT Aligned Sequences. 
SIFT scores interpretation are available here. 
Current version for precomputed predictions: SIFT 6.2.0 
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12.  Curate 
The Variant Panel can also be used to curate information on variants which are 
stored in the Local Variant Databases. 
 

12.1 Variant Flagging 

 
In the ‘Annotation’ tab of the Variant Panel, you can flag your variant. 
 
You can set pathogenicity information via the ‘Pathogenicity class’ section. 
 
You can select ACMG evidence for your variant based on the scientific context. To 
do so, click on ‘Show Details’ button and use the ‘Selected’ column checkboxes to 
select ACMG evidence. The selected evidence will be displayed in the variant panel. 
The suggested ACMG pathogenicity class is then assessed based on selected 
evidence.  
 

 
 

 

The final pathogenicity classification is defined by the user in the ‘User defined 
pathogenicity class’ section in the Variant panel. 
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The color of variant graphic items in the Local Variant Database track depends on 
its classification. By default:  

1. Unclassified (light gray),  
2. Benign (dark green),  
3. Likely benign (light green), 
4. Uncertain significance (dark gray),  
5. Likely pathogenic (Orange)  
6. Pathogenic (red).  

 
You can also add a comment on your variant via a free text field in the ‘Note’ 
section. 
 

12.2 Variant Occurence Management 

 
In the ‘Occurrences’ tab of the Variant Panel, you can record different occurrences 
of the same variant. 
 
To create an occurrence, in the ‘Occurrences’ sub-tab, click on the 'New 
Occurrence' button. You can then enter specific information about the Occurrence. 
Fields RNA Analysis, Phenotype and Comment are enabled. 
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Clicking on the ‘see HPO’ button, you can select a phenotype for your occurrence as 
referred to the HPO. A link to the HPO website is also provided. By double clicking 
on a phenotype, the selection field will be filled in.  The HPO-IDs will be reported 
in the final ‘Occurrences’ sub-tab.    

 

 
The entered information related to the occurrence are shown in a table in the 
‘Occurrences’ sub-tab. 

 

You can then manage your occurrences by deleting, editing, or adding existing 
occurrences: 

 
 

 
12.3 Variant History 

 
The Variant Panel has a ‘Variant History’ sub-tab which provides a history related 
to a same variant when updates are provided.  
 
The variant history includes the ‘Date’, the ‘User’, the final pathogenicity 
‘Classification’, the ‘Notes’ as written in the ‘Annotation’ sub-tab and the ‘ACMG 
Evidence’.  
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13. Reporting 

You can create a final report including all information related to one specific 
variant. This functionality is available via the ‘Variant Panel’ > ‘Report’ sub-tab. 
 

 
 
In the menu on the right, you can select features to display in the final report.  
By right clicking in the report, you can save the report in a PDF or HTML format. 
When the report is saved in HTML, it can be opened in Microsoft Word. 
 
Note: 
Splicing section: Only the impact on the nearest reference splice site (±2bp at the 
donor and acceptor site of an exon) is included in the report. For each splice site 
predictor (SpliceSiteFilder, MaxEntScan, NNSplice), Alamut Visual Plus evaluates 
how much the site score changed by computing the following ratio:  
 

(𝑠𝑐𝑜𝑟𝑒 𝑜𝑛 𝑡ℎ𝑒 𝑚𝑢𝑡𝑎𝑡𝑒𝑑 𝑠𝑒𝑞𝑢𝑒𝑛𝑐𝑒  −  𝑠𝑐𝑜𝑟𝑒 𝑜𝑛 𝑡ℎ𝑒 𝑟𝑒𝑓𝑒𝑟𝑒𝑛𝑐𝑒 𝑠𝑒𝑞𝑢𝑒𝑛𝑐𝑒)
𝑠𝑐𝑜𝑟𝑒 𝑜𝑛 𝑡ℎ𝑒 𝑟𝑒𝑓𝑒𝑟𝑒𝑛𝑐𝑒 𝑠𝑒𝑞𝑢𝑒𝑛𝑐𝑒  

 
An impact of the splicing is detected if the splice site scores have changed from 
more than 1% on average or if the variant is at less than 5 bps of the splice site. 

 
14. Exporting (batch-like feature) 

Export internal Variants 

To export variants already entered in Alamut™ Visual Plus to Excel, to tab-delimited 
text files or to VCF, go to:  

- menu 'Variants' > 'Local Variants Databases'  
- Select the source Local Variant Database 
- Click on ‘Explore/Export’ button 

The ‘Variant Exporter’ pops-up. Select options, fields you need to export and the 
folder where you need to save the exported variants.  
 

 
 



 
 
 

 
ALAMUT VISUAL PLUS 
© SOPHiA GENETICS 2022. All rights reserved.    
FOR RESEARCH USE ONLY. NOT FOR USE IN DIAGNOSTIC PROCEDURES. 

73 

 

 
All greyed fields in the ‘Column filters’ are exported by default.  
 
Export Variants with external annotation 

For each variant entered in the software, Alamut™ Visual Plus generates a set of 
annotations. Annotations are gathered for each variant and can be exported by 
ticking the “All annotations” checkbox.  

 
15. Connect with an API  

Alamut™ Visual Plus includes a programmatic access functionality through an 
Application Programming Interface (API) enabling external tools to control the 
software. Notably, the search bar is open to external software: any software tool or 
web page can be customized to request Alamut™ Visual Plus to display any 
information that can be processed by the search bar. 

 

The server listens to local HTTP GET requests coming through the port that is 
specified in the Options dialog box (see above). The default port is set to 10000 but 
it can be changed to any available port in the Options dialog box (menu ‘Settings’ > 
‘Network’ > ‘API’ section). 
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15.1 Specifications  

Four HTTP GET requests can be processed by Alamut™ Visual Plus: version, 
search, open and annotate.  

Search, open and annotate require the user or the third-party software to provide 
its institution ID and API key. If you don’t have one yet, please 
contact support@sophiagenetics.com. 

A detailed description of the API can be found here: 
https://extranet.interactive-biosoftware.com/Alamut_Visual_Plus_API_2.0.0.html 
 

15.2 Version 
http://127.0.0.1:10000/version 

Upon receiving this request, useful for testing purposes, Alamut™ Visual Plus returns 
an output with its current version and name, along with the list of external sources 
and their versions as a json file. 

15.3 Search  
http://127.0.0.1:10000/search?institution=XXXXXX&apikey=YYYYYYYY&request=NM_000059.
3%3Ac.4563A%3EC 
 

This request asks Alamut™ Visual Plus to display the result of a search (here variant 
“NM_000059.3:c.4563A>C” (after percent-encoding see 
https://www.urlencoder.org)).  

Any request that can be processed by the search field of Alamut™ Visual Plus (see 
10.4.3. Search bar (Extended Access Feature)) can be processed with the “search” 
endpoint. 

15.4 Open 

 
-connect.interactive-biosoftware.com%2FBAM%2Fexample.bam 

 
This request asks Alamut™ Visual Plus to open a BAM file located at http://rd-
connect.interactive-biosoftware.com/BAM/example.bam  (the path is percent-encoded, 
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see https://www.urlencoder.org). A gene or a genomic region has to be opened 
beforehand in this case via the search endpoint.  
The path to a local path should contain “file://” as in the examples below: 

http://127.0.0.1:10000/open?institution=XXXXXX&apikey=YYYYYYYY&filetype=bam&path= 
file%3A%2F%2F%2FG%3A%2Fgenetics%2Ftest%2FMLH1%E2%80%AFgrch37.bam 

This will open file:///G:/genetics/test/MLH1 grch37.bam (which is 
G:\genetics\test\MLH1 grch37.bam under Windows). 

http://127.0.0.1:10000/open?institution=XXXXXX&apikey=YYYYYYYY&filetype=bam&path=fi
le%3A%2F%2F%2FUsers%2Ftest%2FMLH1%20grch37.bam 

This will open file:///Users/test/MLH1 grch37.bam. 

The open API endpoint supports BAM, CRAM and Sanger file types. 

15.5 Annotate 
http://127.0.0.1:10000/annotate?institution=XXXXXX&apikey=YYYYYYYY&variant=NM_00024
9.4%3Ac.121G%3EC 
 

This request asks Alamut™ Visual Plus to annotate the following percent-encoded 
variant: NM_000249.4:c.121G>C 

A JSON file will be returned containing data available in the system regarding this 
variant: variant features (at genomic, transcript and protein levels), references and 
data available in external catalogues (ClinVar, dbSNP, gnomAD, etc), splicing effect, 
scores from missense predictors (if relevant), etc. 

The annotate API endpoint supports variants provided according the HGVS 
nomenclature rules. 

Miscellaneous 

Menus  

• Application 
o Open Gene 
o GRh37 
o GRh38 
o Mitochondrial view 
o Home 

• File 
o Open BAM/CRAM File 
o Open BAM from URL 
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o Open Sanger File 
o Export Fasta Sequence 

• View 
o Focus on 
o Show ruler 
o Color nucleotides 
o Use amino acid 3 letter code 
o Full Screen 
o Show navigation bar 
o Increase Font 
o Decrease Font 
o Reset Font 
o Enter Full Screen 

• Web 
o View gene in Ensembl Browser  
o View displayed region in Ensembl Browser  
o View entire region in NCBI Sequence Viewer  
o View entire region in UCSC Browser  
o View HGNC symbol report for this gene  
o View gene in OMIM® web site  
o View gene in GENATLAS web site  
o View gene in Gene Reviews web site  
o View Uniprot entry for the product of this gene 

• Variant 
o New Variant 
o Local Variants Database  

• Tools 
o Genetic Code 
o Compare Amino Acids 
o Assembly Mapping 
o Take Screenshot 
o Nomenclature validation dialog 
o Variant validation dialog 

• Help 
o Software Documentation 
o Data Sources 
o License Agreement 
o Software Reference 
o Contact Support 

 

Navigation with keyboard 

Use the following keys to navigate in Alamut™ Visual Plus:  

• Left arrow key: step shift the sequence to the left 
• Right arrow key: step shift the sequence to the right 
• Up arrow key: step shift the tracks upwards 
• Down arrow key: step shift the tracks downwards 

 



 
 
 

 
ALAMUT VISUAL PLUS 
© SOPHiA GENETICS 2022. All rights reserved.    
FOR RESEARCH USE ONLY. NOT FOR USE IN DIAGNOSTIC PROCEDURES. 

77 

16. Quality Control Procedures 
External genomic data has been successfully tested and implemented in Alamut 
database. Frontend functionalities and data display have been successfully tested 
and implemented.   
 

16.1 Warnings and Limitations  

For Research Use Only. Not for use in diagnostic procedures. 
Alamut™ Visual Plus does not provide recommendations for medical diagnosis. It 
must be used by human genetics professionals with discretion. SOPHiA GENETICS 
does not guarantee the accuracy of information and predictions it provides. 
 

16.2 Residual Risks 

No residual risk has been identified as part of Alamut Visual Plus risk assessment. 
 

17. Other Information 
 

17.1 Training 

Before using the Software, video tutorials are provided in the software homepage to 
get started. Further requests on live demo and support can be addressed to:  
support@sophiagenetics.com 
 

17.2 Responsibility 

This system solely supports the intended user and does not substitute or replace the 
intended user's experience and/or responsibility during its use. It must always be 
possible for the user to proceed without the assistance of the system.  

17.3 Documentation 

This user manual describes the use of an interpretation software for genomic 
variations that must be used with care. It is therefore important that all users of 
the software:  

1. Read this guide carefully before use.  
2. Have access to this guide at all times. 
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18. Symbols 
 

 
User Manual, Operating instructions 

 
Research Use Only 

 
 

 
Reference Number 
 

 
 Manufacturer 

 
 

19. Support 
 
In case of difficulty using the product, contact our support line and e-mail 
mentioned on the "Summary Information" page of this user guide. 


